
 

 

 

OFFICIAL 

Ver 1.2 

© Ordnance Survey Ltd 2021  
 

ORDNANCE SURVEY GB 

O S  M A S T E R M A P  T O P OG R A P H Y  L A Y E R   

–  B U I L D I N G  H E I G H T  A T T R I B U T E   

–  G E T T I N G  S T A R T E D  G U I D E  
 



OS MASTERMAP TOPOGRAPHY LAYER – BUILDING HEIGHT ATTRIBUTE – GETTING STARTED GUIDE 
December 2021 

 

OFFICIAL 

© Ordnance Survey Ltd 2021 
Page 2 of 26 

 

Version history 

Version Date Description 

1.0 2017 Initial release. 

1.1 10/2020 Minor updates. 

1.2 12/2021 Minor formatting updates. 
 

Purpose of this document 

This document provides information about and insight into the OS MasterMap Topography Layer – Building 

Height Attribute product and its potential applications. For information on the contents and structure of 

OS MasterMap Topography Layer – Building Height Attribute, please refer to the Overview and Technical 

Specification. 

The terms and conditions on which OS MasterMap Topography Layer – Building Height Attribute is made 

available to you and your organisation are contained in that Ordnance Survey customer contract. Please 

ensure your organisation has signed a valid current customer contract to be able to use OS MasterMap 

Topography Layer – Building Height Attribute. 

We may change the information in this document at any time, giving you the notice period set out in your 

contract. We do not accept responsibility for the content of any third-party websites referenced or 

accessed in or through this document. 

This document has been screened according to Ordnance Survey's Equality Scheme. If you have difficulty 

reading this information in its current format and would like to find out how to access it in a different 

format (braille, large print, computer disk or in another language), please contact us on: 

+44 (0)3456 05 05 05. 

Copyright in this document 

© Ordnance Survey Limited 2021. This document (including for the avoidance of doubt, any mapping 

images reproduced within it) is protected by copyright and apart from the rights expressly granted within 

this document to use the content, all rights are reserved. Any part of this document may be copied for use 

internally in your organisation or business so that you can use OS MasterMap Topography Layer – Building 

Height Attribute under the terms of your licence (but not otherwise). 

No part of this document may be reproduced or transmitted in any form or by any means (including 

electronically) for commercial exploitation, onward sale or as free promotional material without getting the 

written consent of Ordnance Survey beforehand. 

Trademarks 

Ordnance Survey, OS, OS Logos, OSGB36, OS MasterMap and TOID are registered trademarks, and 

OS MasterMap Topography Layer – Building Height Attribute is a trademark of Ordnance Survey, Britain’s 

mapping agency. 

Contact details 

OS website ‘Contact us’ page (https://www.ordnancesurvey.co.uk/contact-us).  

https://www.ordnancesurvey.co.uk/contact-us
https://www.ordnancesurvey.co.uk/contact-us
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1. Purpose of this getting started guide 

OS MasterMap Topography Layer – Building Height Attribute is an enhancement to the OS MasterMap 

Topography Layer product. The enhancement is supplied in a comma-separated values (.csv) format and is 

supplied separately from OS MasterMap Topography Layer’s Geography Markup Language (GML) data files. 

Therefore, if you want to use the Building Height Attribute data, you will need to join the two files first. 

No schema changes to OS MasterMap Topography Layer are required to use the Building Height Attribute 

data. 

The Building Height Attribute dataset is derived from and dependant on multiple other data sources, so is 

reliant on their accuracy. In addition, if a building has multiple heights or is in close proximity to an extreme 

landscape change (if it is on a hill or by a river, for example), then this may affect the data quality. Multiple 

quality checks are made on the data before release to mitigate any errors, and confidence levels are high on 

the dataset, but please verify or contact OS if any of the data does not look correct. 

This Getting Started Guide is designed to walk you through the steps you need to take to join the Building 

Height Attribute data with OS MasterMap Topography Layer data within a geographic information system 

(GIS). The guide also outlines how to load the data into a database. 

Within this guide, there are parts showing you how to re-structure the unique identifier (TOID: 

topographic identifier). We would advise against this as doing so means you will be unable to confidently 

match the feature in the dataset to other OS products or datasets using TOIDs or OpenTOIDs as their 

feature identifier. 

First, you will need to check the format of your TOIDs in your translated OS MasterMap Topography 

Layer data and compare it to the format of the TOIDs in the Building Height Attribute data. The format of 

the TOIDs needs to be the same so that the Building Height Attribute data can be joined with the 

OS MasterMap Topography Layer data. The step-by-step instructions on how to do this can be found in 

Section 4. 

If you will be using the data in a GIS, you will then need to load the Building Height Attribute data into your 

GIS and join it with the OS MasterMap Topography Layer data. The step-by-step instructions on how to do 

this can be found in Section 5 and Section 6. 

If you will be using the Building Height Attribute data in a database environment, then the data will need to 

be imported into a database. The step-by-step instructions on how to do this can be found in Section 7. 
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2. What do I need to use this data? 

2.1 System requirements 

OS MasterMap Topography Layer – Building Height Attribute is designed to be joined to and then used as 

part of the OS MasterMap Topography Layer. Section 6 gives guidance on how to join this data to your 

Topography Layer holding. 

As it is a part of the OS MasterMap Topography Layer, Building Height Attribute is designed for use in a 

digital map within geographic information systems (GIS) and database systems. For details of Ordnance 

Survey’s Licensed Partners who can assist you with incorporating Building Height Attribute in their systems, 

please see the systems / software Software for mapping page on the OS website 

(https://www.ordnancesurvey.co.uk/business-government/tools-support/gis/software). 

Ordnance Survey does not recommend either suppliers or software products as the most appropriate 

system will depend on many factors, such as the amount of data being taken, resources available within the 

organisation, the existing and planned information technology infrastructure and last but by no means least, 

the applications that the data will be used for. However, as a minimum, the following elements will be 

required in any system: 

• A means of reading the data, either in its native format or by translating it into a file format or for 

storage in a database 

• A means of storing and distributing the data, perhaps in a database or through a web-based service 

• A way of visualising and / or querying the data, typically a GIS 

2.2 Backup provision of the product 

You are advised to copy the supplied data to a backup medium before following the steps in this guide. 

2.3 Typical data volumes for the product 

For reading purposes, it is recommended that users store the data on a single hard disc as this will speed 

up the ability of your computer to read the data. The uncompressed file size for the full supply of Great 

Britain (GB) is 2.6 Gb. 

https://www.ordnancesurvey.co.uk/business-government/tools-support/gis/software
https://www.ordnancesurvey.co.uk/business-government/tools-support/gis/software
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3. Product supply information 

3.1 Product supply format 

Building Height Attribute data is supplied in comma-separated values (.csv) file format. Files will not be 

compressed. 

3.2 Product supply mechanism 

OS MasterMap Topography Layer – Building Height Attribute is supplied as an online download. You can 

download data in .csv format from the OS Data Hub (https://osdatahub.os.uk/). 

The product is currently still available for customers to request through OS Orders 

(https://orders.ordnancesurvey.co.uk/sso/login.shtml). 

https://osdatahub.os.uk/
https://osdatahub.os.uk/
https://orders.ordnancesurvey.co.uk/sso/login.shtml
https://orders.ordnancesurvey.co.uk/sso/login.shtml
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4. How do I manage the .csv data? 

The Building Height Attribute .csv contains the attribute OS_TOPO_TOID, which is the topographic 

identifier (TOID) from OS MasterMap Topography Layer. This TOID is the attribute that is used to join 

the data to your OS MasterMap Topography Layer data. More information about TOIDs is available in the 

OS MasterMap Topography Layer Product Guide and Technical Specification documents, which are both 

available on the OS MasterMap Topography Layer Product Support page of the OS website 

(https://www.ordnancesurvey.co.uk/business-government/tools-support/mastermap-topography-support). 

4.1 Checking TOIDs 

TOIDs are stored in GML as a character string, with the prefix ‘osgb’, and can be comprised of either a  

13-digit integer or a 16-digit integer after ‘osgb’ (for example, osgb1000001799480255). Ordnance Survey 

recommends that TOIDs are stored in this format. 

Note: The changing of a TOID format means that you will not be able to confidently match features with other 

Ordnance Survey products or with datasets created by third parties using TOIDs or OpenTOIDs as the key feature 

identifier. We would therefore recommend that, except where absolutely necessary, you do not make changes to the 

identifier format. 

Some of the methods available to translate OS MasterMap Topography Layer from GML alter the TOID 

from the format in which it is supplied in the GML. We have tested a small sample of these methods to 

ascertain how the TOID is dealt with during some translation processes. The following table details how 

some of the translators we tested deal with TOIDs; please look at your own data to investigate how your 

translation process will affect the TOIDs in your data. 

Table 1: TOID processing results for four translators. 

Translator Processing of TOIDs 

Miso InterpOSe 
Removes ‘osgb’ from the beginning of TOIDs and adds three leading zeroes 

to 13-digit TOIDs. 

Astun Loader Preserves raw GML TOID format but renames column from TOID to fid. 

Pitney Bowes MapInfo Removes ‘osgb’ from the beginning of TOIDs. 

QGIS Preserves raw GML TOID format. 

It is recommended that the OS_TOPO_TOID attribute in the OS MasterMap Topography Layer – Building 

Height Attribute .csv files be edited if it is found that the OS MasterMap Topography Layer TOID has been 

altered during the translation process, although how TOIDs are managed is up to your discretion. To aid 

this process, we have created some script that can be run alongside a gawk application that will alter 

TOIDs in the .csv files in two different ways. It is recommended that you create a backup copy of your .csv 

file before you make any changes to it. 

https://www.ordnancesurvey.co.uk/business-government/tools-support/mastermap-topography-support
https://www.ordnancesurvey.co.uk/business-government/tools-support/mastermap-topography-support
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4.2 Databases 

If your TOID column requires altering, steps are outlined in Section 7 detailing how this can be achieved in 

a database environment. This can also be achieved using the gawk process outlined in the following sub-

section. 

4.3 Reformatting the TOID attribute 

There are several options which will allow the user to reformat the TOID attribute before joining it with 

the TOID field in OS MasterMap Topography Layer. 

For smaller amounts of data, the simplest option is to use the free open-source text editor called 

Notepad++. Using this text editor, simply load up the Building Height Attribute .csv data and then, using 

the search and replace option, simply replace the 'osgb' part of the TOID name with either nothing or 

three leading zeroes ('000'). Remember to save the file with a new name once this procedure has been 

carried out. 

The following sub-sections detail other steps that you can take to reformat the TOID attribute in the 

Building Height Attribute .csv, so that the format matches that of the TOID attribute in your translated 

OS MasterMap Topography Layer, Topographic Area data. The reformatting of TOID is a very quick option 

which will take five minutes to set up and process on a national set of data for OS MasterMap Topography 

Layer – Building Height Attribute. 

Note: If the format of the TOIDs in your translated OS MasterMap Topography Layer data matches that in the 

Building Height Attribute .csv, please skip to Section 5. 

Two script reformatting options are presented below: 

• Script to remove ‘osgb’ from Building Height Attribute TOIDs: Recommended for use if your 

translator removes ‘osgb’ from your OS MasterMap Topography Layer TOIDs but does not add any 

leading zeroes to shorter 13-digit TOIDs. 

• Script to remove ‘osgb’ and add ‘000’ to 13-digit Building Height Attribute TOIDs: 

Recommended for use if your translator removes ‘osgb’ from your OS MasterMap Topography Layer 

TOIDs and adds three leading zeroes to shorter 13-digit TOIDs. 

Note: In order to use either reformatting fix, you will need to download gawk (https://code.google.com/archive/p/gnu-

on-windows/downloads), a tool that uses pattern-matching principles to do simple data re-formatting tasks. 

1. Download the gawk tool and save the zip file in any location. 

2. Extract the ‘gawk.exe’ file to a directory containing the Building Height Attribute .csv file you wish to 

alter (this must contain only the .csv to alter and no other files). There must be no spaces in the entire 

file path to that directory as this will cause the process to fail. 

3. Both reformatting processes require you to create an .awk file and a .bat file alongside the gawk 

application. These need to be saved in the same directory as the gawk application and Building Height 

Attribute .csv file you wish to alter. The structure of the .awk file specified in the following sub-section 

remains unchanged regardless of which of the two script reformatting options you are using. Unlike the 

.awk file, the content of the .bat file is different for both reformatting options. The format to use in 

both instances is described after the .awk file detail in the following sub-section. 

https://code.google.com/archive/p/gnu-on-windows/downloads
https://code.google.com/archive/p/gnu-on-windows/downloads
https://code.google.com/archive/p/gnu-on-windows/downloads
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4.3.1 Generating the .awk file 

1. Copy and paste the following code into a new text editor document (such as Notepad++): 

# COMMAND LINE gawk -v leadingZeroes=TRUE|FALSE -f bha_fixTOID.awk infile > outfile 

BEGIN {  

     FS = ","  

     OFS = ","  

}  

{  

     sub("osgb","",$1)  

     if (leadingZeroes == "TRUE")  

           $1 = sprintf("%016d",$1)  

     print  

}  

2. Save the file as bha_fixTOID.awk in the same directory as the gawk application and Building Height 

Attribute .csv file. 

Note: This code refers to the file name of this .awk file. If you choose to name your .awk file differently to our 

suggested name, please change the code to reflect the name of the .awk file you are using. 

4.3.2 Generating the .bat file 

Script to remove ‘osgb’ from TOIDs: 

1. If using the first reformatting option (i.e. Script to remove 'osgb' from TOIDs), please copy the 

following text into a new text editor document and save the document with a .bat extension in the 

same directory as the gawk application, .awk file and .csv file: 

@rem --- Line below to remove OS_TOPO_TOID "osgb" prefix only 

FOR /F "tokens=*" %%A IN ('dir *.csv /s/b') DO (gawk -v leadingZeroes=FALSE -f bha_fixTOID.awk 

%%A > _%%~NA%%~XA)  

pause  

exit 

Note: This code refers to the file name of this .awk file. If you choose to name your .awk file differently to our 

suggested name, please change the code to reflect the name of the .awk file you are using. The .bat file does 

not have to have a specific name, only the .awk file has to have a specific name because the .bat file refers to 

the name of the .awk file. 
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Script to remove ‘osgb’ and add ‘000’ to 13-digit Building Height Attribute TOIDs: 

1. If using the second reformatting option (i.e. Script to remove ‘osgb’ and add ‘000’ to 13-digit Building 

Height Attribute TOIDs), please copy the following text into a new text editor document and save the 

document with a .bat extension in the same directory as the gawk application, .awk file and .csv file: 

@rem --- Line below to remove OS_TOPO_TOID "osgb" prefix + add leading zeroes 

FOR /F "tokens=*" %%A IN ('dir *.csv /s/b') DO (gawk -v leadingZeroes=TRUE -f bha_fixTOID.awk 

%%A > _%%~NA%%~XA)  

pause  

exit 

Note: This code refers to the file name of this .awk file. If you choose to name your .awk file differently to our 

suggested name, please change the code to reflect the name of the .awk file you are using. The .bat file does 

not have to have a specific name. Only the .awk file has to have a specific name because the .bat file refers to 

the name of the .awk file. 

4.3.3 Executing the reformatting operation 

1. For both reformatting options, navigate to the directory where the .bat file is saved and execute it by 

double clicking the file. An MS-DOS window will appear. 

2. Once the process is complete, press the return key to close the window. 

The directory should now contain a new Building Height Attribute .csv file with the same name as the 

original but starting with an underscore. This .csv file will contain a copy of the original with the TOID 

attribute altered. 

Note: If you wish to check how this process has altered the TOID attribute, do not open the .csv file with 

Microsoft Excel because Excel will reformat the TOID and read it as a number field. Instead, open the .csv file in 

a text editor as this will keep the TOID correctly formatted. 

4.3.4 Merging .csv files 

It is likely that the user will wish to merge 5 X 5km2 tiles together to create an area of interest before 

loading into a GI application. The following procedure can be followed to undertake this operation: 

1. Place all the .csv files into an empty folder. 

2. Copy and paste the following script into a text editor (such as Notepad++), and, once copied, give the 

file a name which explains its function. In this case, we have called the file mergedBHAdata.bat. 

copy *.csv mergedBHAdata.csv 

Navigate to the directory where the .bat file is saved and execute by double clicking the file. This will 

create a new file called mergedBHAdata.csv from all the component .csv files in the folder. 

3. Delete the original 5 X 5km2 from the folder, leaving just the newly created mergedBHAdata.csv file in 

the folder. 
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4. Copy and paste the following script into a text editor (such as Notepad++), and, once copied, give the 

file a name which explains its function. In this example, we have called the file Append_BHA_Header.bat. 

copy BHA_Header.csv+ mergedBHAdata.csv BHA_Data.csv 

5. Download the Building Height Attribute header file from the 'Links and downloads' section of the 

OS MasterMap Topography Layer Product Support page on the OS website 

(https://www.ordnancesurvey.co.uk/business-government/tools-support/mastermap-topography-

support). 

Figure 1: Location of the Building Height Attribute header file on the OS website. 

 

6. Place the downloaded header file for Building Height Attribute data into the same folder as the merged 

Building Height Attribute data file, along with the batch file that was created in Step 4. 

7. Run the batch file. A new merged .csv file containing the header will be created called BHA_Data.csv. 

https://www.ordnancesurvey.co.uk/business-government/tools-support/mastermap-topography-support
https://www.ordnancesurvey.co.uk/business-government/tools-support/mastermap-topography-support
https://www.ordnancesurvey.co.uk/business-government/tools-support/mastermap-topography-support
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5. How do I load the Building Height Attribute product 

into a GIS? 

The Building Height Attribute product can be loaded into several geographic information systems (GIS). 

This section describes how to load it into commonly used GIS. For more information on other GIS that the 

Building Height Attribute product is compatible with, please speak to your OS Technical Relationship 

Consultant. 

The format of the TOIDs in your .csv may have an impact on how you import the .csv into a GIS. If you 

have not had to alter the TOID format, GIS software should read the OS_TOPO_TOID column in the .csv 

file as a text string automatically, which should match your OS MasterMap Topography Layer TOIDs. 

Therefore, you do not have to carry out any extra steps when importing your .csv file into a GIS, so you 

may wish to move on to the next section. 

However, if you have had to alter the OS_TOPO_TOID in the Building Height Attribute .csv by removing 

the ‘osgb’, this attribute may be read as a number by a GIS; this will mean that any leading zeroes added will 

be deleted and the TOID field in the .csv will be incompatible with the TOID field in the OS MasterMap 

Topography Layer data which is formatted as a text string. We have outlined some steps which will allow 

the user to specify the field types for .csv files being imported to some GIS environments. The processes 

described in the following sub-sections will work with individual or merged versions of the .csv data. 

5.1 ArcMap 

These notes outline how to load Building Height Attribute data into ArcMap using the .csv file you have 

received and / or altered. The notes have been prepared using version 10.5 of ArcMap. The instructions 

will also work for ArcPro and version 10.6.1 of ArcMap. 

If you are importing an unmodified version of the .csv file, then you can import this directly into ArcMap via 

the Add Data button. 

If you are importing a .csv with an altered OS_TOPO_TOID attribute, you will need to carry out the steps 

detailed below before importing. 

You can create a schema information file which describes the format of the fields contained within a text 

file. A schema information file is always named ‘schema.ini’ and is stored within the same directory as the 

.csv you wish to import into ArcMap. 

1. Open a new text editor document and copy the following script into it: 

[_BHA_Data.csv] 

Format=CSVDelimited 

ColNameHeader=True 

Col1=OS_TOPO_TOID Text 

Col2=OS_TOPO_VERSION Long 

Col3=BHA_ProcessDate DateTime 

Col4=TileRef Text 

Col5=AbsHMin Double 

Col6=AbsH2 Double 

Col7=AbsHMax Double 

Col8=RelH2 Double 

Col9=RelHmax Double 

Col10=BHA_Conf Long 
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Note: The section of code within the square brackets refers to the file name of the .csv you wish to import. 

Please alter this line to reflect the file name of your .csv. 

2. Save this in the same directory as the .csv you wish to import into ArcMap, naming it schema.ini. 

This file will now be read by ArcMap when you import the .csv file into it and will specify the field type 

for each field within the .csv file. This ensures that the TOID is treated as a text string. 

5.2 QGIS 

These notes outline how to load Building Height Attribute data into QGIS using the .csv file you have 

received and / or altered. The notes have been prepared using version 2.14.15 of QGIS Desktop. The 

instructions will also work for version 3.16 of QGIS. 

If you are importing an unaltered .csv file which contains TOIDs in the format they are found in the raw 

GML, then you can import this file via the Add Delimited Text Layer icon. If you wish to import this .csv file 

via the Add Vector Layer option, you will have to create a .csvt file as outlined below or all the fields will be 

imported as ‘String’. 

If you are importing a modified version of the .csv file, you must create a .csvt file or the TOID field may be 

imported as a number. 

A .csvt file is the equivalent of a schema.ini file for use in QGIS. It specifies the field types of a text file you 

are importing into QGIS. 

It must be named the same as the .csv file it is referring to and be stored in the same directory as the .csv 

file you wish to import into QGIS. 

1. Please open a new text editor document and copy the following script into it: 

"String","Integer","Date","String","Real","Real","Real","Real","Real","Integer" 

2. Save this in the same directory as the .csv file you wish to import into QGIS with the same file name as 

the .csv file and with the file extension .csvt. 

3. You can now import the .csv file into QGIS by selecting the Add Vector Layer or Add Delimited Text Layer 

options in QGIS; this file will now be read by QGIS during the import process and will specify the field 

type for each field within the .csv file. 
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5.3 MapInfo 

These notes outline how to load Building Height Attribute data into MapInfo using the .csv file you have 

received and / or altered. The notes have been prepared using version 16.0.0 of MapInfo (64bit version). 

How you have altered the TOID field in the .csv file will affect the methodology employed when importing 

the .csv file into MapInfo. If you have retained the raw GML TOID format or added leading zeroes into 

your TOID field, then MapInfo will automatically pick this up as a character field, so it can be added to 

MapInfo in the following process: 

1. Launch MapInfo. 

2. Navigate to the Open dialog box either by using the icon or by clicking File > Open. 

3. Select Comma Delimited CSV (*.csv) from the Files of type drop-down, then navigate to where the .csv 

file is stored. 

4. Select the .csv file you wish to open and click Open. 

5. The Open dialog box will close, and a Comma Delimited CSV Information dialog box will appear. 

Ensure the Use first line for column titles check box is ticked, then click OK to close the dialog box and 

open the .csv file. 

The TOID field should be formatted as a text string and should include leading zeroes. 

If you have removed ‘osgb’ but not added any leading zeroes, please follow the steps outlined above. You 

should see that the TOIDs are formatted as numbers and contain decimal places. If you then navigate to the 

directory where you have stored the .csv file, you should see that MapInfo has created a .TAB file with the 

same name as the .csv file. When this .TAB file is opened within a text editor, something similar to the text 

below should be displayed: 

Note: The field types may vary depending on previous processing. The section of code within the chevrons refers to 

the file name of the Building Height Attribute .csv. 

!table 

!version 300 

!charset WindowsLatin1 

Definition Table 

File "<_Name of Tile.csv>" 

Type ASCII Delimiter "," Titles Charset "WindowsLatin1"  

Fields 10 

OS_TOPO_TOID Integer ; 

OS_TOPO_VERSION Smallint ; 

BHA_ProcessDate Char (10) ; 

TileRef Char (6) ; 

AbsHMin Float ; 

AbsH2 Float ; 

AbsHMax Float ; 

RelH2 Float ; 

RelHMax Float ; 

BHA_Conf Smallint ; 
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As you can see here, the field OS_TOPO_TOID has a data type of ‘Integer’. 

6. Manually change this in the text editor to Char (20) ; to specify this field type as text, then save the 

.TAB file before closing. 

7. Close the original .csv file displayed in MapInfo by selecting File > Close Table. 

8. Open the .TAB file that you just edited. The TOID field should now be formatted correctly, and you 

can use this .TAB file to join to the OS MasterMap Topography Layer data holdings. 

Note: If you re-open the .csv file in MapInfo and choose to overwrite the table, the TOID field will be formatted 

as a number again. Instead, you should use the .TAB file rather than the .csv file. 

Now you have loaded the .csv file, you will need to export it as a .dbf (dBASE DBF) file and create an index 

on the TOID column in the table. To do this, follow these steps: 

1. In the ribbon toolbar, select the Table tab and then select Export. Navigate to where you wish to save 

the .dbf. Ensure the Save as type is set to dBASE DBF (*.dbf). 

2. Select the Table tab in the ribbon menu, then select Table and from that drop-down, select modify 

structure, which opens the Modify table structure dialog box. 

3. Ensure you have opened the table structure for the Building Height Attribute data because this is the 

data we want to create an index on. For the column of data containing the TOID value, tick Indexed 

box. Apply this index by clicking OK. 
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6. How do I join the Building Height Attribute .csv to 

OS MasterMap Topography Layer? 

In order to use the Building Height Attribute data within GIS it must first be joined to OS MasterMap 

Topography Layer. This section describes this process for some commonly used GIS. 

The .csv data should be loaded into your GIS with the TOID column formatted as it is in your 

OS MasterMap Topography Layer data holdings (see previous sections for more details). 

A join between these two datasets will link them together based on the unique identifier between the two 

datasets: the TOID. This will result in the buildings in your OS MasterMap Topography Layer data holdings 

being associated with a set of building heights. 

6.1 ArcMap 

These notes outline how to join Building Height Attribute data to OS MasterMap Topography Layer in 

ArcMap. The notes have been prepared using version 10.5 of ArcMap. 

In the procedure described below, it is assumed that the user has converted OS MasterMap Topography 

Layer from the .gz supply into an ESRI shapefile format using translation software. It is important to ensure 

that any pre-processing of Building Height Attribute data is completed before commencing an ESRI ArcGIS 

session. 

1. Launch ArcMap and load the Building Height Attribute .csv file and the OS MasterMap Topography 

Layer shapefile. 

2. Right-click on the Topographic Area Layer in the table of contents, navigate to Joins and Relates and 

select the Join… option as shown in the following screenshot: 

 

3. In the Join Data dialog box that opens, select the .csv file you want to join to the OS MasterMap 

Topography Layer data from the drop-down under option 2 in the list. 
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4. For options 1 and 3 listed in the Join Data dialog box, select the TOID column in each dataset to 

specify this as the common attribute between the data that you wish to join on.  

5. In the Join Options section of the Join Data dialog box, you can choose to keep all records or keep only 

matching records; this will mean that you will only have the buildings with heights left after the join. 

6. Select OK to carry out the join – it is better not to choose the Validate Join option as this requires a 

longer processing time. 

When you open the attribute table of the layer you have joined the .csv file to, you should see the 

Building Height Attribute columns at the end of the attribute table. You can use the 'Select by attribute 

tool' to display all the buildings in the attribute table to inspect the Building Height Attribute data more 

easily in ArcMap. If you experience long processing times when querying this join, please export the file 

and then carry out these queries (see step 7 for more details on exporting the file). 

7. Lastly, in order to save this join to the layer, close the attribute table and right-click the layer in the 

table of contents. Select Data > Export Data to save a copy of this shapefile with the Building Height 

Attribute data joined to it. Please be aware that large volumes of data may increase the processing time 

of this step. 

6.1.1 Alternative method to speed up the join process 

If you are finding that the join process is taking a long time, you can try the alternative method outlined 

below which will speed up the join. 

Before loading the .csv file into the GIS, you could use ArcCatalog to export the .csv table into a 

Geodatabase (single). When doing this, you will have the option to edit the format of the field properties 

for the TOID data. This will allow you to add an attribute index to the table. Once the index has been 

added, the join process should be quicker. The notes below outline these steps fully: 

1. Navigate to the .csv file in ArcCatalog. 

2. Right-hand click on file and select the drop-down Export, then choose To Geodatabase (single). This will 

open up the Table to Table dialog box. 

3. Select an output location, which needs to be within a file geodatabase, and create a name for the new 

table you are going to create. 

4. Finally, in the Field Map (optional) window, right-click on the TOID field and select the Properties option, 

which will open the Output Field Properties dialog box. 

5. In the Properties box, there will be a row called ‘Length’ with a number. This number has to be less 

than 80 to allow you to add an attribute index later in the process. As TOIDs are never more than 

20 characters in length, this number has to be greater than 20. 

6. Click OK to close the window. 

7. To complete the export, select OK. 

8. Open up ArcGIS and navigate to the Arc Toolbox. 

9. Select Data Management Tools, then choose Indexes from the drop-down and open the Add Attribute 

Index tool.  



OS MASTERMAP TOPOGRAPHY LAYER – BUILDING HEIGHT ATTRIBUTE – GETTING STARTED GUIDE 
December 2021 

 

OFFICIAL 

© Ordnance Survey Ltd 2021 
Page 18 of 26 

 

10. Select the table in the File Geodatabase you have just created. In the ‘Fields to Index’ window, tick the 

box next to the row which contains the TOID. 

11. Select OK to carry out this operation. 

12. Once the index has been added, carry out the instructions at the beginning of the section to join the 

Building Height Attribute data to your OS MasterMap Topography Layer data. 

6.2 QGIS 

These notes outline how to join Building Height Attribute data to OS MasterMap Topography Layer in 

QGIS. The notes have been prepared using version 2.14.15 of QGIS Desktop. The instructions will also 

work for version 3.16 of QGIS. 

1. Launch QGIS and load the .csv file and the OS MasterMap Topography Layer data. 

2. Right-click the Topographic Area Layer and select Properties from the options list. 

3. Click the Joins tab within the Layer Properties dialog box. 

4. Press the green plus icon at the bottom of this dialog box, and in the Add vector join dialog box that 

opens, select the .csv file as the Join layer. 

 

5. For the Join field and Target Field options in the Add vector join dialog box, select the TOID column in 

each dataset to specify this as the common attribute between the data you wish to join on.  

6. Select OK, then close the Layer Properties dialog box. 

7. When you open the attribute table of the Topographic Area Layer, you should see the Building Height 

Attribute columns at the end of the attribute table. You can use the Select features by expression tool 

to display all the buildings in the attribute table to inspect the Building Height Attribute data more easily 

in QGIS. 
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8. Lastly, in order to save this join to the layer, close the attribute table and right-click the layer in the 

table of contents. Select Save as from the options list to save a copy of the layer with the Building 

Height Attribute data joined to it. 

6.3 MapInfo 

These notes outline how to join Building Height Attribute data to OS MasterMap Topography Layer in 

MapInfo. The notes have been prepared using version 12.0.2 of MapInfo. 

1. Launch MapInfo and load the .dbf file and the OS MasterMap Topography Layer .TAB file. 

2. Select the SQL Select button on the ribbon toolbar, and choose the SQL Select option which opens the 

SQL Select dialog box. Leave the ‘*’ (asterisk symbol) in the Select Columns box to preserve all fields in 

both tables. 

3. From the Tables drop-down, select the OS MasterMap Topography Layer data and the .dbf file you 

wish to join. This will populate these tables within the 'from Tables' box. 

 

4. Click within the 'where Condition' box, then select from the Columns drop-down the TOID field from 

the OS MasterMap Topography Layer data. This will populate this field within the 'where Condition' 

box. 
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5. Enter an equals sign after this column name and then use the ‘Columns’ drop-down to select the TOID 

field from the .dbf file which will populate this field after the equals sign in the ‘where Condition’ box. 

This action will have written the SQL query to join these tables via the TOID columns; the SQL query 

should look similar to that shown in the preceding screenshot. 

6. In the ‘into Table Named’ box, enter the name you wish to call the new table containing both the 

OS MasterMap Topography Layer data and .dbf file data. 

7. Click OK to close the SQL Select dialog box. 

8. A new table will open containing the joined records. 

 

9. Select the Files drop-down from the top toolbar, then choose the Save Query option to save this join. 

If you close the query table and open the version you have saved, a map view of the join will open in a 

window browser. Please be aware that as you are dealing with large files, these steps may take some 

time to process. 

6.4 Dealing with duplicate records 

Users should be aware that in Building Height Attribute data, features are not broken at tile edges. 

Therefore, once the .csv files have been merged and then joined with features in the OS MasterMap 

Topography Layer Topo_Area table, duplicate records will exist in the data. Depending upon which GI 

application is being used, tools are available within the application to remove duplicate features. 

• ESRI ArcGIS: In ArcGIS, use the option Geoprocessing > Dissolve to remove the duplicate features 

within the merged data. The output can be saved into file geodatabase, created as described earlier in 

this section. 

• QGIS: In QGIS, use the option Vector > Geoprocessing > Dissolve to remove the duplicate features 

within the merged data. The output will be a shapefile containing the de-duplicated data. 

• MapInfo Professional: There are several ways to remove duplicate features in MapInfo Professional. 

The following article from precisely.com details how to use the Delete Duplicates tool in MapInfo 

Professional to remove duplicate records but retain map objects:  

• Precisely.com article on 'Deleting duplicate records and retaining map objects in MapInfo Pro' 

(https://customer.precisely.com/s/article/Deleting-duplicate-records-and-retaining-map-objects-in-

MapInfo-

Pro?language=en_US#:~:text=Open%20the%20table%20or%20tables,Duplicates%20on%20the%20R

unning%20tab.) 

https://customer.precisely.com/s/article/Deleting-duplicate-records-and-retaining-map-objects-in-MapInfo-Pro?language=en_US#:~:text=Open%20the%20table%20or%20tables,Duplicates%20on%20the%20Running%20tab.
https://customer.precisely.com/s/article/Deleting-duplicate-records-and-retaining-map-objects-in-MapInfo-Pro?language=en_US#:~:text=Open%20the%20table%20or%20tables,Duplicates%20on%20the%20Running%20tab.
https://customer.precisely.com/s/article/Deleting-duplicate-records-and-retaining-map-objects-in-MapInfo-Pro?language=en_US#:~:text=Open%20the%20table%20or%20tables,Duplicates%20on%20the%20Running%20tab.
https://customer.precisely.com/s/article/Deleting-duplicate-records-and-retaining-map-objects-in-MapInfo-Pro?language=en_US#:~:text=Open%20the%20table%20or%20tables,Duplicates%20on%20the%20Running%20tab.
https://customer.precisely.com/s/article/Deleting-duplicate-records-and-retaining-map-objects-in-MapInfo-Pro?language=en_US#:~:text=Open%20the%20table%20or%20tables,Duplicates%20on%20the%20Running%20tab.
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7. How do I import the Building Height Attribute 

product into a database? 

The Building Height Attribute product can be loaded into several databases. This section describes how to 

load it into commonly used databases, including PostgreSQL and Oracle. For more information on other 

databases that the Building Height Attribute product is compatible with, please speak to your OS Technical 

Consultant. 

7.1 PostgreSQL 

These notes outline how to load Building Height Attribute data into a PostgreSQL database using the .csv 

file. The notes have been prepared using version 2.0 of PostGIS for PostgreSQL 9.3. 

7.1.1 Loading instructions 

1. Open the PGAdmin tool (this can be found on the Windows Start Menu > PostgreSQL). 

2. Either connect to an existing database or create a new database. 

3. Open the public schema (although in a production environment, it is advised to use a different schema) 

and create the table using the following, or similar, script: 

create table <Insert table name>( 

OS_TOPO_TOID character varying (20), 

OS_TOPO_TOID_VERSION smallint, 

BHA_ProcessDate date, 

TileRef character varying (6), 

AbsHMin real, 

AbsH2 real, 

AbsHMax real, 

RelH2 real, 

RelHMax real, 

BHA_Conf smallint 

);  

4. Once the tables have been created, the data can be loaded into the table using the SQL COPY, adding 

the .csv option as the first line contains a header record. 

COPY <Insert table name> FROM ‘<Insert file path to bha.csv>’ DELIMITER ‘,’ CSV HEADER; 

Note: The sections within the chevrons require your postGIS table name and the file path to your data (the latter 

must contain no spaces in the path). 
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7.1.2 Altering the TOID 

The following section details the steps that you can take to reformat the TOID attribute in the Building 

Height Attribute data you’ve loaded, so that the format matches that of the TOID attribute in your 

translated OS MasterMap Topography Layer Topographic Area data. 

Note: If you have used the gawk application process outlined in Section 4 or if the format of the TOIDs in your 

translated OS MasterMap Topography Layer data match that in the Building Height Attribute data, you do not 

require this step. 

Two reformatting options are presented below: 

1. Script to remove ‘osgb’ from Building Height Attribute TOIDs: 

Recommended for use if your translator removes ‘osgb’ from your OS MasterMap Topography Layer 

TOIDs but does not add any leading zeroes to shorter 13-digit TOIDs. 

Run the following SQL command: 

UPDATE <insert table name> SET <insert TOID column name> = trim('osgb' from os_topo_toid); 

COMMIT; 

2. Script to remove ‘osgb’ and add ‘000’ to 13-digit Building Height Attribute TOIDs: 

Recommended for use if your translator removes ‘osgb’ from your OS MasterMap Topography Layer 

TOIDs and adds three leading zeroes to shorter 13-digit TOIDs. 

Run the following SQL command: 

UPDATE <insert table name> set <insert TOID column name> = 

(CASE 

WHEN char_length(<insert TOID column name>) = 20 THEN trim('osgb' from <insert TOID column 

name>) 

ELSE ('000' || trim('osgb' from <insert TOID column name>)) 

END); 

COMMIT; 

Note: The sections inside the chevrons require your postGIS table name and TOID column name. 
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7.2 Oracle 

The following set of instructions assumes a basic knowledge of Oracle databases and SQLLDR, which is the 

package that can be used to load Building Height Attribute .csv into the database. Other options are 

available for loading data into Oracle databases. 

If required, copy the data file(s) to an appropriate location. It is worth noting that the file(s) will need to be 

unzipped and therefore you will need in the region of 1.3 Gb of free space. 

Once the data is in an appropriate location, the next stage is to uncompress the *.zip file to .csv. This can 

be done using a package such as WinZip or 7Zip. 

7.2.1 Loading instructions 

1. Create the tables using the SQL below. 

2. Prior to running the script, the tablespace that the tables are going to reside in needs to be altered 

from <TablespaceName> to the tablespace that is being worked in. 

3. If the table already exists, you will firstly need to drop the table using the following SQL: 

DROP TABLE <Insert Table Name> CASCADE CONSTRAINTS; 

4. Next you will need to create a new empty table using the following SQL: 

CREATE TABLE <Insert Table Name> 

( 

MI_PRINX  NUMBER (38, 0), 

OS_TOPO_TOID VARCHAR2 (20), 

OS_TOPO_VERSION NUMBER, 

BHA_PROCESSDATE DATE, 

TILEREF  VARCHAR2 (6), 

ABSHMIN  FLOAT, 

ABSH2  FLOAT, 

ABSHMAX  FLOAT, 

RELH2  FLOAT,  

RELHMAX FLOAT, 

BHA_CONF  NUMBER 

); 

DROP SEQUENCE BHA_data_S; 

CREATE SEQUENCE BHA_data_S 

START WITH 1 

INCREMENT BY 1; 

COMMIT; 
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5. Create an SQLLDR control file containing the following information: 

OPTIONS (SKIP=1, BINDSIZE=20971520, READSIZE=20971520, ROWS=2500, ERRORS=10, SILENT = 

FEEDBACK ) 

 

LOAD DATA 

CHARACTERSET WE8ISO8859P1 

INFILE '<Insert file path to bha.csv>' 

 

APPEND 

INTO TABLE BHA_data 

FIELDS TERMINATED BY "," 

OPTIONALLY ENCLOSED BY '"' 

TRAILING NULLCOLS 

( 

MI_PRINX EXPRESSION " BHA_data_S.NEXTVAL", 

OS_TOPO_TOID, 

OS_TOPO_VERSION, 

BHA_PROCESSDATE DATE "YYYY-MM-DD", 

TILEREF, 

ABSHMIN,  

ABSH2, 

ABSHMAX,  

RELH2, 

RELHMAX, 

BHA_CONF 

) Preface 

Note: The sections inside the chevrons require you to input your table name and the file path to your data (the latter 

must contain no spaces in the file path). 

6. Once this file is created, it can be called from a .bat file to run it on the box that holds the database 

rather than a remote machine. The contents of the .bat file should be similar to the following: 

@sqlldr <username>/<password>@<service name> control= <name of ctl file created previously> 

Pause 

7. ‘Double click’ the .bat file that you’ve just created to load the data into the BHA_DATA table in your 

database. 
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7.2.2 Altering the TOID 

Note: If you have used the gawk application process outlined in Section 4 or if the format of the TOIDs in your 

translated OS MasterMap Topography Layer data match that in the Building Height Attribute data, you do not 

require this step. 

Two reformatting options are presented below: 

1. Script to remove ‘osgb’ from Building Height Attribute TOIDs: 

Recommended for use if your translator removes ‘osgb’ from your OS MasterMap Topography Layer 

TOIDs but does not add any leading zeroes to shorter 13-digit TOIDs. 

Run the following SQL command: 

UPDATE <Insert Table Name> set <Insert Table Name>.<insert TOID column name>=substr(<Insert 

Table Name>.<insert TOID column name>,5); 

2. Script to remove ‘osgb’ and add ‘000’ to 13-digit Building Height Attribute TOIDs: 

Recommended for use if your translator removes ‘osgb’ from your OS MasterMap Topography Layer 

TOIDs and adds three leading zeroes to shorter 13-digit TOIDs. 

Run the following SQL command: 

UPDATE <Insert Table Name> set <Insert Table Name>.<insert TOID column name>= 

(CASE 

WHEN length(os_topo_toid) = 20 then substr(<Insert Table Name>.<insert TOID column name>, 5) 

ELSE ('000' || substr(<Insert Table Name>.<insert TOID column name>, 5))  

END); 

Note: The sections inside the chevrons require you to enter your table name and TOID column name. 
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8. Further information about the Building Height 

Attribute product 

Further information about the Building Height Attribute product (including FAQs) can be found on the 

Product Support page for OS MasterMap Topography Layer on the OS website 

(https://www.ordnancesurvey.co.uk/business-government/tools-support/mastermap-topography-support). 

https://www.ordnancesurvey.co.uk/business-government/tools-support/mastermap-topography-support
https://www.ordnancesurvey.co.uk/business-government/tools-support/mastermap-topography-support
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